Online Exams
Student instructions

Last updated: 29 June 2020

How to type in Japanese ......................................................................................................................... 22
    Microsoft Word ................................................................................................................................. 22
    Google Docs .................................................................................................................................. 22

How to type in other languages that use accents (e.g. French or Spanish) ........................................... 23
    Microsoft Word ................................................................................................................................. 23
    Google Docs .................................................................................................................................. 24

How to include mathematical formulae and calculations ........................................................................ 25
    Microsoft Word ................................................................................................................................. 25
    Google Docs .................................................................................................................................. 25
Introduction

Please note that these instructions are purely suggestions – there are many methods for completing the tasks listed below, so if you prefer to use another solution please do so.

In this document you will find instructions on how to complete your exams electronically, in both Microsoft Word 2016 and Google Docs. If you are using a different version of Microsoft Word the functions available may be different.

Students are responsible for ensuring that their answer sheets are legible, including any pictures, diagrams, graphs or other content.

If you have questions that are not addressed in this document, please visit the Covid-19 Exams webpage and view the Frequently Asked Questions.
Online Exams – Student instructions

Last updated: 1 July 2020

Turnitin submission for online exams

Before submission

1. Make sure that the file you want to submit is in Microsoft Word or PDF format.
2. Make sure the file is 100MB or less in size.
3. Save the file you want to submit and close the software (e.g. Microsoft Word) you used to write your submission on your computer.
4. Use a stable, secure internet connection.
5. Start the submission as early as possible.
6. If you experience any problems, try a using different browser and/or device.

Important: If you used Apple Pages on a Mac to write your submission, you must export to PDF before you submit. Turnitin does not accept *.pages files.

During submission

To submit your file, find the Turnitin link in the module in Moodle signposted with the Turnitin logo: 📑. If you see more than one Turnitin link, ask your tutor to which one you should use to submit your exam. Once you have determined the correct link:

1. Click on the Turnitin link.
2. Click Submit Paper 🌂 on the right.
Online Exams – Student instructions

Last updated: 1 July 2020

3. Type the title of your submission.
4. Drag and drop your file into the submission area (blue arrow).
5. Check the box to confirm that this submission is your own work.
6. Click Add submission.

7. Wait for your submission to be uploaded.
8. After a few seconds, you will see the message “Your submission has been successfully uploaded”.
9. Click Close (top right).
10. The Moodle page will refresh and the Turnitin Paper ID will appear next to the submission title.

Blue card submissions

Students who are eligible for a blue card submission need to follow the instructions here: Blue marking cards.

After submission

Check your Brookes Gmail inbox for a digital receipt of your submission from Turnitin. You must keep this email, as this provides proof that you made the submission.
How do I know that I successfully submitted?

If a Turnitin Paper ID has appeared in your Moodle page and you have received the digital receipt (which also includes the Turnitin Paper ID) of your submission in your Brookes Gmail inbox, then your submission has been successfully uploaded to Turnitin. Alternatively, check in Moodle that a ‘View Digital Receipt’ link has appeared on the left of the submission title, as shown:

Converting your submission file to PDF

Convert to PDF in Microsoft Word (Windows)

1. Click the File tab
2. Click Save As. To see the Save As dialog box, you may need to choose a location to save to by clicking Browse.
3. In the File Name box, enter a name for the file, if you haven't already.
4. In the Save as type list, click PDF (*.pdf). If you want the file to open in the selected format after saving, select the Open file after publishing check box.
5. Click Save.
Convert to PDF in Microsoft Word (Mac)

1. Click **File**.
2. Click **Save As**.
3. Click **File Format** towards the bottom of the window.
4. Select **PDF** from the list of available file formats.
5. Give your file a name, if it doesn't already have one.
6. Click **Export**.

Convert to PDF in Apple Pages (Mac)

1. Click **File** (from the menu at the top of your screen).
2. Choose **Export to**.
3. Select **PDF**.

Convert to PDF in Apple Pages on iPhone/iPad (iOS)

1. Tap **More** 😞
2. Tap **Export**.
3. Choose and tap **PDF**.

Convert to PDF in Microsoft Word on iPhone/iPad (iOS)

To export your Word document or Excel workbook to PDF format on iOS:

1. Tap the **File** icon (at the top left).
2. Choose and tap **Export**.
3. Choose and tap **PDF**.
Guidance on the University’s Academic Conduct Regulations

There are many different ways that work can be assessed as an alternative to traditional invigilated examinations. For example, you might be given an essay title where you have to write the essay and submit it within a few days, or you might be given a 24 hour period in which you have to spend a specific number of hours completing an online exam.

As a general rule, the University’s academic conduct regulations will always apply and your work will normally be put through Turnitin, so unless you have specifically been told about a variation to the conduct rules, follow the below guidance to keep within the regulations:

You should:

- always write your answers yourself, in your own words. Upgrade have some tips about paraphrasing;
- if you need to use other people’s words, figures, pictures or ideas, (e.g from a book or another source,) for part of your examination answer, properly reference them using the correct referencing style. Upgrade have some tips about avoiding plagiarism;
- work on your own without getting help from anyone else;
- submit your own work via Moodle;

You should not:

- help other people complete their exam or share your exam with anyone else – this is a breach of the conduct regulations and you would be penalised;
- make contact with anyone else taking the same exam as you during the exam period – this may look like an attempt to cheat. If you have an issue with the exam paper itself, contact the exams team, the module leader, or read the “Technical Issues” guidance on the Covid-19 Exams webpage;
Online Exams – Student instructions

Last updated: 1 July 2020

- copy previous work you have submitted for other assignments or exams, this will be deemed duplication and is a breach of the regulations;
- gain access to any unauthorised material relating to the assessment before the information is released;
- use custom writing services.

If the assessment is an online exam, check what information you are allowed to consult during the exam period, e.g. written or printed material, or electronic information.

The full set of regulations can be found at the below link. All potential breaches of the Academic Misconduct Regulations will be investigated and may be subject to a penalty.

Variations

Sometimes, module teams will decide that one or more of the regulations will not be applied to the specific assessment that you have to do. If they do, this will be said in writing in advance, and the information should be available on the module’s Moodle page. For example, you might be allowed to consult specific resources such as books or websites during the exam, or you might be permitted to discuss other people’s ideas without including an in-text citation and reference list.

We understand that it can be confusing to know which academic conduct rules apply in relation to each format. This guidance is intended to help.

The academic conduct regulations are designed to ensure fairness for all students, so any breaches of them are treated very seriously and will undergo an investigation just like a breach for any other assessment. Therefore, if you are not sure whether you’ll be allowed to do something, you should check the information on the Moodle course page, and ask your module team for clarification.
Online Exams – Student instructions

Last updated: 1 July 2020

How to access Google Docs templates for exam answer sheets

Microsoft Word templates for examination answer sheets will be available via Moodle along with the other exam materials. If you do not have access to Microsoft Word, there are Google Doc templates for Multiple Choice, Written and Mixed Paper examinations. To access these, go to the Google Docs homepage – this can also be accessed in the Google Apps menu, as shown below:

Make sure you are logged in to your Google@Brookes account and click on Template gallery:

![Google Docs homepage screenshot](image-url)
Online Exams – Student instructions

Last updated: 1 July 2020

In the Basics section, you will see three templates – Answer Sheet – Mixed Paper template, Answer Sheet – Multiple Choice template and Answer Sheet – Written Exam template. Click on the one you want to use:

A copy of the template will then be added to your Google Drive main folder for you to complete:

Once you have completed your answer sheet, you can download it as either a PDF or Microsoft Word document to be uploaded to Turnitin. Click on File and then on Download.
and select the format you want to use:

![Answer Sheet - Multiple Choice template](image)

Work to be uploaded to Turnitin should be saved as a PDF or Microsoft Word document. If you are using Apple Pages on a Mac, you must convert your answer sheet to a PDF before uploading. **Please do not try to upload a *.pages file to Turnitin, as this will not be accepted.**
How to include photographs or pictures in your answer

Google Photos

Your Google@Brookes account includes access to Google Photos, which can be configured to automatically sync photographs taken with a mobile phone to your Google account. To set this up, you need to have the Google Photos app installed on your phone through the Play Store (for Android) or the App Store (for iPhone).

Once you have installed Google Photos, you need to set it to sync photographs to your Google@Brookes account. Once you have done this, you can access and download your photographs via the Google Apps menu:
Snipping Tool

If the picture you want to include is available on your PC, you can use the Snipping Tool to take a screenshot, and then following the instructions below on how to insert it into a Word document or Google Doc. The Snipping Tool can be found in the Windows Accessories folder in the Start menu:

Navigate to the window you want to take a screenshot of, then open the Snipping Tool and click New:
Drag the cursor around the area of the screen you want to capture. You can then copy and paste the screenshot into your answer sheet.

**Microsoft Word**

Select the location in the document where you want to insert a photo or picture. Click on the **Insert** tab, and then on **Pictures**:

Navigate to the folder on your PC where your photos/pictures are saved, and select the picture you want to insert, then click **Insert**:
Google Docs

Select the location in the document where you want to insert a photo or picture. Click on the Insert tab, and then on Image:

![Google Docs Insert Image](image)

Then select where the picture is stored (e.g. Upload from computer if it is on your PC, or Photos if it is in your Google Photos), click on the picture you want to insert and click Insert.
How to include diagrams in your answer

The simplest method for including diagrams in your answer would be to hand draw them and then take a photograph, which can be inserted into your answer paper – see the instructions above on including photographs and pictures.

Microsoft Word

You can create graphics using the SmartArt option within Microsoft Word. Select the location in the document where you want to insert the graphic. Click on the Insert tab, and then on SmartArt:

Select the type of SmartArt graphic you want to include, and click OK:
Edit the fields to create the graphic you want to include:

[Text] • [Text]

[Text] • [Text]

[Text] • [Text]

Google Docs

Select the location in the document where you want to insert a diagram. Click on the Insert tab, and then on Drawing:

Click New, and a dialog box will appear where you can create a graphic using Shapes and Connectors. Click Save and Close to insert the graphic into your answer sheet:
How to include graphs in your answer

The simplest method for including graphs in your answer would be to hand draw them and then take a photograph, which can be inserted into your answer paper – see the instructions above on including photographs and pictures.

There are also a number of websites that provide electronic graph paper, such as print-graph-paper.com/virtual-graph-paper (straight line graphs only) and fillable-grid-online.pdffiller.com/.

Microsoft Word

You can create graphs within Microsoft Word. Select the location in the document where you want to insert the chart. Click on the Insert tab, and then on Chart:

Select the type of graph you want to include, and click OK:
Edit the fields to create the graph you want to include:

![Microsoft Word chart](image)

**Google Docs**

Select the location in the document where you want to insert a graph. Click on the **Insert** tab, and then on **Chart**, then select the type of graph you want to include:

![Google Docs chart](image)
To edit the fields to create the graph you want to include, click to select the graph and then click the **Link** symbol in the top right corner and select **Open source**:

This will open a Google Sheet where you can amend values and other information:
How to type in Japanese

Microsoft Word

Please see these instructions on how to type in Japanese in Microsoft Word. There are also instructions on how to install a Japanese keyboard.

Google Docs

To access the Japanese Input Method Editor in Google Docs, follow the instructions below.

1. Go to myaccount.google.com/.
2. Go to Data and personalisation > General preferences for the web.
3. Click on Input Tools, and then click Add Language.
4. Add the languages that you need and select Input Method Editor.
5. Scroll down and under Options tick the box for Keep dictionary synchronised between Google services.

In Google Docs, go to File > Language and select the language you need. Once you have it set up under Input Tools in myaccount.google.com/ as outlined above, you should be able to easily switch between languages, including the dictionary.
How to type in other languages that use accents (e.g. French or Spanish)

Microsoft Word

Select the location in the document where you want to insert the accented letter. Click on the Insert tab, and then on Symbol:

![Insert tab and Symbol option]

Click on More Symbols:

![More Symbols option]

Select the correct font, then select the accented letter you want to use and click Insert:

![Symbol dialog box with selected letter]

Insert
Online Exams – Student instructions

Last updated: 1 July 2020

You can keep the Symbol menu open and continue typing as normal, to save having to reopen it every time you want to insert an accented letter.

Google Docs

Select the location in the document where you want to insert the accented letter. Click on the Insert tab, and then on Special characters:

The Insert special characters dialog will appear – click to select the accented letter you want to insert into your document:

You can keep the Special Characters menu open and continue typing as normal, to save having to reopen it every time you want to insert an accented letter.
How to include mathematical formulae and calculations

The simplest method for including mathematical formulae and calculations in your answer would be to hand write them and then take a photograph, which can be inserted into your answer paper – see the instructions above on including photographs and pictures.

Microsoft Word

To type an equation in Word, select the location in the document where you want to insert the equation. Click on the Insert tab, and then on Equation:

Use the Equation Tools Design menu to create your equation:

Google Docs

To type an equation in Google Docs, select the location in the document where you want to insert the equation. Click on the Insert tab, and then on Equation:
Use the **Equation toolbar** to create your equation: